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1. About the CODESYS Integration manual

1.1 Symbols and notation

Symbols for general notes

NOTE This shows general information.

More information
This shows where you can find more information.

Example

This shows an example.

How to ...
This shows a link to a video for help and guidance.

Symbols for hazard statements

DANGER!

This shows dangerous situations.

If the guidelines are not followed, these situations will result in death, serious personal injury, and equipment
damage or destruction.

WARNING

This shows potentially dangerous situations.

If the guidelines are not followed, these situations could result in death, serious personal injury, and equipment
damage or destruction.

CAUTION

This shows low level risk situation.

If the guidelines are not followed, these situations could result in minor or moderate injury.

NOTICE

This shows an important notice

Make sure to read this information.

1.2 Intended users of the CODESYS Integration manual

The CODESYS Integration manual is intended for designers and developers who want to integrate CODESYS projects with
the DEIF controllers.
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1.3 Software versions

The information in this document relates to software versions:

Software Details Version

iE 250
iE 250 Marine

Controller application 2.0.10.x or later 

iE 350
iE 350 Marine

Controller application 2.0.10.x or later 

BSP Board Support Package (Operating System)  5.0.0.x or later 

CODESYS libraries CODESYS 2.0.10.x or later 

CODESYS CODESYS runtime 3.5.20.40 or later 

CODESYS IDE PC software for development of CODESYS applications 3.5.20.40 or later 

iE x50 CODESYS TSP CODESYS Target Support Package (TSP) 1.3.2.2 or later 

1.4 Data security

While DEIF has taken great attention to data security and has designed the product to be a secure product, we recommend
adopting Information Technology (IT) and Operational Technology (OT) security best practices when connecting the
controller to a network.

To minimise the risk of data security breaches we recommend:
• Only connect to trusted networks and avoid public networks and the Internet.
• Use additional security layers like a VPN for remote access.
• Restrict access to authorised persons.

1.5 Legal information

Third party equipment

DEIF takes no responsibility for installation or operation of any third party equipment. In no event shall DEIF be liable for any
loss of profits, revenues, indirect, special, incidental, consequential, or other similar damages arising out of or in connection
with any incorrect installation or operation of any third party equipment.

Warranty

NOTICE

Warranty

The warranty will be lost if the warranty seals are broken. The iE 350 racks may only be opened to remove,
replace, and/or add a hardware module or the internal RTC battery (if fitted). The procedure in the Installation
instructions must be followed. If the rack is opened for any other reason, and/or the procedure is not followed,
then the warranty is void.

If the iE 7 display or iE 250 controller is opened, then the warranty is void.

Trademarks

DEIF and the DEIF logo are trademarks of DEIF A/S.
Bonjour® is a registered trademark of Apple Inc. in the United States and other countries.
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Adobe®, Acrobat®, and Reader®are either registered trademarks or trademarks of Adobe Systems Incorporated in the
United States and/or other countries.
CANopen® is a registered community trademark of CAN in Automation e.V. (CiA).
SAE J1939® is a registered trademark of SAE International®.
CODESYS® is a trademark of CODESYS GmbH.
EtherCAT®, EtherCAT P®, Safety over EtherCAT®, are trademarks or registered trademarks, licensed by Beckhoff
Automation GmbH, Germany.
VESA® and DisplayPort® are registered trademarks of Video Electronics Standards Association (VESA®) in the United States
and other countries.
Google® and Google Chrome® are registered trademarks of Google LLC.
Linux® is a registered trademark of Linus Torvalds in the U.S. and other countries.
Modbus® is a registered trademark of Schneider Automation Inc.
Torx®, Torx Plus® are trademarks or registered trademarks of Acument Intellectual Properties, LLC in the United States or
other countries.
Windows® is a registered trademark of Microsoft Corporation in the United States and other countries.

All trademarks are the properties of their respective owners.

Disclaimer

DEIF A/S reserves the right to change any of the contents of this document without prior notice.

The English version of this document always contains the most recent and up-to-date information about the product. DEIF
does not take responsibility for the accuracy of translations, and translations might not be updated at the same time as the
English document. If there is a discrepancy, the English version prevails.

Copyright

© Copyright DEIF A/S. All rights reserved.
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2. Prepare and install CODESYS

2.1 Essential components

To use CODESYS with your controller you must have installed:

Component Reason

CODESYS Development System (IDE) To create and edit your CODESYS projects. 

CODESYS licence A licence to use CODESYS. 

DEIF CODESYS TSP package Support package to access the DEIF specific hardware. 

DEIF CODESYS libraries Functions related to the DEIF applications and features. 

2.2 CODESYS Development System (IDE)

You can download the CODESYS Development System (IDE) free of charge direct from CODESYS by visiting the CODESYS
Store: *

https://store.codesys.com/en/codesys.html

NOTE * DEIF is not responsible for any external links or content.

More information
See Download necessary software for links to the software downloads.

2.3 Target Support Package (TSP)

The Target Support Package (TSP) is a configuration that enables the CODESYS project to communicate with the DEIF
hardware.

You must install the CODESYS Development System (IDE) before installing the package.

More information
See Download necessary software for links to the software downloads.

2.4 DEIF CODESYS libraries

CODESYS libraries are collections of reusable objects. These are typically functions.

Each DEIF library provides you with access to the different controller functions. When you include the library in your
CODESYS project you can then access the objects associated.

Libraries must be downloaded and then installed with the Library Manager to use them. You can also install them directly
from the package (.package) files if the CODESYS Development System (IDE) is both installed and associated to the file
type.

More information
See Download necessary software for links to the software downloads.

More information
See DEIF library functions for details of the functions and their use.
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2.5 Download necessary software

To use CODESYS development you need to download the CODESYS Development System (IDE), Target Support Package
(TSP), DEIF libraries, and the latest application software for your controller.

Download the required software from your product’s dedicated software page:

Download the software

iE 250 https://www.deif.com/software/?product=17655

iE 250 Marine https://www.deif.com/software/?product=20133

iE 350 https://www.deif.com/software/?product=22285

iE 350 Marine https://www.deif.com/software/?product=20135
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3. CODESYS features

3.1 CODESYS online help

The CODESYS IDE provides online help for more information about the programming environment and how to get started.

With the CODESYS Online Help you can learn about:
• Visualization
• Programming references
• Standard CODESYS libraries *

NOTE * For information about the DEIF-specific libraries, see DEIF CODESYS Libraries.

Access the CODESYS online help
In the CODESYS IDE, select Help > Contents from the menu.

New to CODESYS development?
If you are new to CODESYS development, we recommend that you start with the guide under the section: Your First
CODESYS Program.
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CODESYS online help in other languages
The help is also available in other languages, and can be changed under:

Tools > Options > International settings
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3.2 CODESYS Development System (IDE)

8

9

3

2

4

5

1

76

No. Item Notes

1. Project tree 

The project tree is an overview of your project. A typical project will consist
of:
• One or more devices (controllers).
• One or more applications containing the Libraries, POUs and tasks.

2. PLC Logic node A PLC Logic node shows that the device is a programmable device and has
no other functions associated to it.

3. Library manager The Library manager contains the libraries for the project. Each library
consists of functions and function blocks that can be used in your programs.

4. Devices tab The Devices tab gives you quick access to the project tree.

5. POUs tab The POUs tab gives you quick access to the project settings menu.

6. Working area 

The working area consists of tabs representing different parts of the project.
Each tab contains different parts of the project. These project parts can be
opened from the project tree.

The picture above shows the working area for the POU, PLC_PRG. The
working area for this POU consists of a declaration workspace, an
implementation workspace and a toolbox menu.

7. Declaration workspace The declaration workspace consists of the variables for the POU functions. 

8. Additional toolboxes Some POUs have additional toolboxes that help you to build your program. 

9. Implementation workspace The implementation workspace is used to program your POU. 
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3.3 Monitor application

3.3.1 How it works

While the program is running on the controller and you're connected to it through CODESYS, you can monitor variable
values in real time. It is also possible to change the value of some variables while you are monitoring the variable values.

You can monitor the variable values of a specific POU (Program Organization Unit) by opening the POU in the working area.

To monitor variables from multiple POUs simultaneously or to track a specific set of variables, you can create a Watch
window.

You can modify variable values in the working area or Watch window by entering or forcing new values to the controller.

3.3.2 Monitor in the working area

When you are connected to the controller through CODESYS, you can open a POU to monitor its variables in the working
area. To open the POU in the working area, double-click on the POU from the project tree.

Alternatively, you can select the POU in the project tree and select Edit object from the right-click menu.

Open the PUO, named PLC_PRG, in the working area by double-clicking it.

In the declaration part of the open POU in the working area, the variable watch list is shown:
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All the variables relating to the open POU are shown in this list. You can change the values of some variables using this
table.

More information
See Writing and forcing variables for more information about how to change the variables values.

In the implementation part of the open POU in the working area, the program function diagram, ladder logic, or code are
shown:

If Inline monitoring is activated, the inline monitoring boxes are placed behind each variable in the code, or next to the
variable in the function block. The inline monitoring boxes shows the actual value of the variable in real-time.

To activate or deactivate Inline monitoring go to Tools > Options to open the Options window. Activate or deactivate the
function under Text editor > Monitoring > Enable inline monitoring.
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3.3.3 Monitor in Watch windows

Watch windows are useful to monitor specific variables in a POU, or to monitor variables from different POUs in a single
window.

You can also change the values of some variables in the Watch window. This is useful, for example, to debug code.

More information
See Writing and forcing variables for more information about how to change the variables values.

Follow these steps to create a watch window:

1. Select Watch 1 from View > Watch to open a watch window.
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•
2. Double-click in an empty cell in the Expression column.

•

3. Select the Input assistant  to open the Input assistant window.
4. Under Categories > Watch Variables, select a variable or group of variables (for example ML300_0) in a POU to

watch:
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•
• Select OK to confirm your selection and continue.

5. Press the Return key to add your selected variable(s) to the watch window.
• Details for the variable(s) (for example, the application and type) are automatically added to the watch window.

6. You can monitor the selected variable(s) in the watch window:

•
• It is also possible to change the values of some variables using this watch window.
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3.3.4 Write and force variables

Some variables in your program can be changed while the program is running. To change the value of the variables in your
program, first prepare a new value for the variable. Then Write or Force the prepared value to the program.

Preparing variables
To change the value of a variable, you must first prepare a replacement value. The new value for the variable is stored in
the Prepared value column. The new variable remains in the Prepared value column until the user chooses to Write or
Force the prepared value to the variable. You can prepare multiple variables and Write or Force all of the prepared values at
the same time.

To prepare a variable of the type INT, DINT, UINT, or STRING:

1. Double-click on the field in the Prepared value column.
2. Enter the new value.
3. Press the Return key or click outside the field.

The Prepared value is ready to be written or forced to the program.

To prepare a variable of the type BOOL:

1. Click on the field in the Prepared value column until the desired value appears.

The Prepared value is ready to be written or forced to the program.

Example of a UINT and BOOL prepared value

Writing variables
When you Write a prepared value to the program, the variable updates during the next run cycle. The new value can be
updated immediately by the program during the next run cycle.

To Write a new variable value to the controller:

1. Prepare the variable value(s).
2. Select Debug > Write values.

• Alternatively press Ctrl+ F7.
3. The Value column updates and shows the prepared value.
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•

Some variables cannot be updated. Typically such variables receive their input from a different source. If you attempt to
Write a new value to such a variable, then the variable value remains unchanged.

Forcing variables
When you Force a prepared value to the program, the variable updates during the next run cycle. The forced value remains
unchanged in the value column, until it is unforced.

Forced variables remain in the system until unforced by the user. The user always receives a warning, when there are
forced variables remaining in the application when logging out.

Follow these steps to Force a new variable value to the controller:
1. Prepare the variable value(s).
2. Select Debug > Force values.

a. Alternatively press F7.
3. The Value column updates and shows the forced values.

• The  icon to the left of the value indicates that the variable is a forced variable.

•

Some variables cannot be updated. Typically such variables receive their input from a different source. If you attempt to
Force a new value to such a variable, then the value in the Value column changes to appear as if it is forced, but any
outputs connected to it will show the original value.
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3.4 Other features

3.4.1 Warm reset

To perform a warm reset, select Online > Reset warm.

After performing a warm reset of the CODESYS program, you must start the CODESYS application again for the application
to run on the controller.
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4. CODESYS in the controller

4.1 Extend your application with CODESYS

You can extend your controller's application with a CODESYS license.

CODESYS is a widely adopted IEC 61131-3 programming environment that enables powerful, flexible, and scalable control
system development. You can use instruction lists, structured text, ladder diagrams, function block design, and sequential
function charts. Use the CODESYS Visualisation to even create your own HMI visualisations for your project.

With CODESYS, you can create and integrate your own CODESYS project with the controller's application. This both
extends the logic and operation of your system, and eliminates the need for an additional external and expensive PLC.

By using CODESYS, you gain a reliable and efficient development platform that aligns perfectly with our product’s
capabilities.

Contact DEIF to order a CODESYS licence for your controller.

4.2 How it works

You create and edit your CODESYS projects locally on your computer using the CODESYS IDE (Integrated Development
Environment). The project can be tested locally and then deployed to the controller and activated.

The controller must be connected to the development computer directly with an Ethernet cable or over an Ethernet network.

Ethernet connection to controller
When programming for the first time, you must use an Ethernet cable connected to Ethernet port ETH0.
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A typical development workflow for your projects
1. Create your project on your local computer:

• You start by launching the CODESYS IDE on your computer, select the target device, and choose the programming
language (for example: Ladder, Structured Text, and so on).
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2. Create and simulate your logic locally:
• This includes creating visualisations, configuring inputs and outputs, and testing logic in the simulation mode before

deploying.
3. Transfer (deploy) your project to the controller:

• Once the project is ready, it is downloaded to the controller over the Ethernet connection.
• This is done by logging into the controller from the IDE and transferring the compiled project.

4.3 DEIF library functions

Each DEIF library provides you with access to different controller functions. When you include the library in your CODESYS
project you can then access the objects associated.

4.3.1 Common libraries (all products)

Library Used for

iE Custom_parameters Configuration of your custom parameters. Includes both
simple and extended settings.

iE IO The Input/output interface between CODESYS and the DEIF
application.

iE Main Information about the controller's processor module,
versions HMI popup, and status texts.

iE Priority data
Fast prioritised readings like selected Live data and [source]
breaker signals.

NOTE: This function block has a high CPU load.

iE UP [UP] Internal libraries for integration between CODESYS and the
DEIF application.

4.3.2 Controller libraries

Controller libraries allow you to access and use the controller functions. Download and use the controller libraries that
match your application.

Controller libraries (LF)
Library Used for

iE LF - Bustie [BTB] BTB controller functions.

iE LF - Genset [GB] GENSET controller functions.

iE LF - Mains [MB] MAINS controller functions.

iE LF - Mains [MB TB] MAINS controller with TB functions.

iE LF - Single genset [GB] SINGLE genset controller functions.

iE LF - Single genset [GB MB] SINGLE genset with MB controller functions.

Controller libraries (LC)
Library Used for

iE LC - Bustie [BTB] BTB controller functions.

iE LC - Genset [GB] GENSET controller functions.

iE LC - Mains [MB] MAINS controller functions.

iE LC - Mains [MB TB] MAINS controller with TB functions.
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Library Used for

iE LC - Single genset [GB] SINGLE genset controller functions.

iE LC - Single genset [GB MB] SINGLE genset with MB controller functions.

iE LC - Single genset [GB NO-MAINS] SINGLE genset controller with no mains functions.

Controller libraries (MS)
Library Used for

iE MS [BTB] BTB controller functions.

iE MS [GB] GENSET controller functions.

iE MS [HYBRID] HYBRID controller functions.

iE MS [IO] IO controller functions.

iE MS [SC] SHORE connection controller functions.

iE MS [SG] SHAFT generator controller functions.

Controller libraries (MP)
Library Used for

iE MP [BTB] BTB controller functions.

iE MP [GB] GENSET controller functions.

iE MP [HYBRID] HYBRID controller functions.

iE MP [EDG] EMERGENCY genset controller functions.

iE MP [SC] SHORE connection controller functions.

iE MP [SG] SHAFT generator controller functions.

4.4 Enable CODESYS

To use your CODESYS project with your controller, CODESYS must be enabled in the parameters. If it’s not enabled, the
CODESYS project cannot run.

CODESYS > Configuration > CODESYS
Parameter Range Notes

Enable Not enabled,
Enabled Enabled allows the CODESYS application to be active.

4.5 Users

Use the admin user to access the WebConfig and configure the controller settings initially. New users must have the
Provisioner permission to access the WebConfig features.

You can configure new users directly with WebConfig or by using PICUS.

CODESYS Localaccessuser
The Localaccessuser is a built-in user that can access the system through the local computer (localhost). It can send API
requests from the command line or the CODESYS application, and is used to show parts of the web interface inside
CODESYS, like viewing logs or setting the time.

You can manage the Localaccessuser like any other user. If you don’t need it, you can delete it. If it’s deleted by mistake,
you can create it again, but make sure the password is left empty.
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The Localaccessuser is restored when a factory reset is done.

4.6 Communication

You can configure the communication settings for the Ethernet ports and VLANs. VLANs are used to manage the Ethernet
traffic routing on the built-in managed switch. On each physical Ethernet port it is possible to assign the behaviour either as
Port Access or Trunk.

By default, all switch ports are configured as access ports with VLAN 1. VLAN 1 is configured with mDNS enabled (for
example, Bonjour service) and IPv4 and IPv6 in mode Link-local only.

We recommend the tool Bonjour service as your mDNS service. Download Bonjour service from the official website:

https://support.apple.com/kb/DL999?locale=en_US *

NOTE * DEIF is not responsible for any external links or content.

More information
Use WebConfig to configure the communication settings with any HTML-capable browser.

4.7 HTML browser access (WebConfig)

Use WebConfig to configure and manage the controller system-settings directly with any HTML-capable browser. You can
use Hostname, IPv6, or IPv4 (if configured) to access the controller.

The application-related settings, such as parameter settings, need to be configured with PICUS.

NOTICE

Certificate security-warning

Access to the controller with a browser requires you to accept a browser security-warning. The controller
certificate is only local and therefore not published online.

More information
See WebConfig for how to access WebConfig and use the features.

4.8 Inputs and outputs

4.8.1 Inputs and outputs

Assign the CODESYS inputs and outputs with the I/O configuration. These inputs and outputs must first be defined in the
CODESYS program, and written to the controller before they can be used.

Function I/O Type Details

Local > CODESYS > Custom
digital input (× 40) Digital input Pulse/

continuous 
If this input is activated, then the controller activates the
corresponding CODESYS digital input function. 

Local > CODESYS >
Outputs > Custom digital
output (× 40)

Digital output Pulse/
continuous 

If CODESYS activates the digital output function, then
the controller activates the digital output. 

Local > CODESYS > State
> CODESYS application OK Digital output Continuous 

If the CODESYS_application_OK output value is "True"
and there are no communication errors, then the
controller activates the digital output.
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Function I/O Type Details

Local > CODESYS > Custom
analogue input (× 40)

Analogue
input - As the value of this input changes, the corresponding

CODESYS analogue input value changes. 

Local > CODESYS > Custom
analogue output (× 40)

Analogue
output - 

As CODESYS changes the value of this analogue
output, the corresponding analogue output value on the
controller changes. 

4.8.2 Activating controller outputs

CODESYS cannot activate controller outputs that are configured for controller functions. CODESYS can activate external
commands. The controller only follows the command if the controller is in remote control.

Example

CODESYS cannot activate the digital input:
Breakers > [Breaker] > Controls > [*B] open

CODESYS can activate the command:
[Breaker] > Open

Where [Breaker] could be Generator breaker, and [*B] could be GB.

4.9 CODESYS alarms

4.9.1 CODESYS application not OK

This alarm alerts the operator that there is a communication problem between
CODESYS and the controller.

If communication between CODESYS and the controller was active and became
inactive, the delay timer starts. If the communication does not become active
within the delay period, the alarm is triggered.

Controller types: This alarm is present in all controllers that have CODESYS
installed.

Active

Inactive

CODESYS 
communication

Time

Delay

CODESYS > Monitoring > Application not OK
Parameter Range

Startup time 0 to 600 s 

Delay 0.00 s to 5 min 

4.9.2 CODESYS configuration conflict

If the same input/output function is configured in CODESYS and the controller at the same time, this alarm is triggered.

The conflict sets the Link_OK output on the controller function block in the program to FALSE.

Controller types: This alarm is present in all controllers that have CODESYS installed.

CODESYS > Monitoring > I/O config conflict
This alarm is always enabled.
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To clear the alarm, you can either:
• Remove the conflicting function from the CODESYS project, and update the CODESYS application on the controller.
• Remove the conflicting function from the controller, and perform a warm reset of the CODESYS application.
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5. WebConfig

5.1 About WebConfig

You can configure and manage the controller system-settings direct with any HTML-capable browser. With WebConfig you
can configure both advanced settings and see more detailed logs and information.

Use the Admin user to access and configure the WebConfig. To use a different user, that user must have the Provisioner
role.

Application-related settings, such as parameter settings, need to be configured with PICUS.

Access to the controller with a browser requires you to accept a browser security-warning, as the controller certificate is
only local and therefore not published.

5.2 Connect to the controller

While DEIF has taken great attention to data security and has designed the product to be a secure product, we recommend
adopting Information Technology (IT) and Operational Technology (OT) security best practices when connecting the
controller to a network.

NOTICE

Initial access

If your controller has not yet been configured, you must use the default access address and permissions. We
strongly recommend that you change the default configuration to protect your system.

You can connect to the controller with Hostname, IPv6, or IPv4 (if configured):
• Hostname

◦ Example: https://ie250-079562.local
• IPv4 address

◦ Example: https://192.168.142.6
• IPv6 address

◦ Example: https://[fe80::226:77ff:fe07:9562]

How to identify the controller's Hostname
You can identify your controller's Hostname by using the Bonjour service and a command prompt. Connect your PC directly
to the ETH0 Ethernet port and run the command:

dns-sd -B _http._tcp local
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Command PromptC:\

Microsoft Windows Version [10.0.26100.3775]
(c) Microsoft Corporation. All rights reserved.

C:\>dns-sd -B _http._tcp local
Browsing for _http._tcp local

C:\

Timestamp
7:42:33.715
7:42:33.715

Add 3 12 local. _http._tcp. Brother QL-580N
Add 3 12 local. _http._tcp. iE250-074854

A/R Flags if Domain Service Type Instance Name

Hostname

This displays all the devices located on your connected network. The Hostname includes the product together with a serial
code.

Examples:
• ie250-076244.local
• ie350-067215.local
• ie650-071522.local

You can then use this Hostname directly in your HTML-capable browser to access the controller configruation.

Username and password
Access the controller with the same username and password as configured on the controller.

5.3 Users

Use the admin user to access the WebConfig and configure the controller settings initially. New users must have the
Provisioner permission to access the WebConfig features.

You can configure new users directly with WebConfig or by using PICUS.

More information
See About Permissions in Cybersecurity.
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5.4 Configuration

5.4.1 Home

The Home page provides a quick overview of the firmware, Ethernet ports and VLAN status. This information can be useful
when troubleshooting or contacting DEIF support.

iE 250 2.0.8.0 LC

HomeHome

Firmware

Hostname Firmware

Version

Storage

iE250-065c35 Slot A v5.0.3.1_0_g0c1761f

Slot B v5.0.3.1_0_g0c1761f

Active slot A

Interface/Ports

iE250 2.0.8.0 LC

Mountpoint /mnt/appdata 8.05% used
15.10% used

tsn0

swp1

swp2

swp3

vlan1

vlan2

vlan3

Mountpoint /var

Users

admin Log out

Roles

Logs

Backup/Restore

Reset

Network

Licence Manager

Minimize

Versions

USB

1

2

3

No. Item Notes

1 Features Available features and pages. 

2 Page Selected page. 

3 User Log in / Log out.

Logged in user is shown.
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5.4.2 Firmware

5.4.2.1 About firmware

Use the firmware feature to update your controllers and displays.

iE 250 2.0.8.0 LC

FirmwareHome

Firmware

Firmware update

Select

Firmware Slot A version v5.0.3.1_0_g0c1761f

Slot B version v5.0.3.1_0_g0c1761f

Drag and drop file here

Active slot A

Users

admin Log out

Roles

Logs

Backup/Restore

Reset

Network

Licence Manager

Minimize

Versions

USB

or

1 2

No. Item Notes

1 Firmware installed Shows the firmware installed in Slot A and Slot B. 

2 Upload Drag and drop the firmware file or use the Select. 

NOTE Alternatively, use PICUS (Tools > Firmware) to update the controllers and displays.

5.4.2.2 Firmware constraints

Controller prerequisites
Before you can apply a firmware update, the controller must meet certain prerequisites. If the controller is in Emulation
mode, or has an ID of 0 (and not part of the system), these constraints do not apply.

Breaker constraint
All controlled breaker(s) must be opened.

Equipment constraint (if controlled)
The controlled equipment must be stopped.

Mode constraint (Marine applications)
The controller must be in Switchboard control.

5.4.2.3 Download firmware

Firmware for your product is available on www.deif.com.
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Download the software

iE 250 https://www.deif.com/software/?product=17655

iE 250 Marine https://www.deif.com/software/?product=20133

iE 350 https://www.deif.com/software/?product=22285

iE 350 Marine https://www.deif.com/software/?product=20135
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5.4.3 Reset (Factory reset)

You can Restart or Factory reset the controller. Before using either feature, the controller must not be in operation or
controlling any equipment.

iE 250 2.0.8.0 LC

HomeHome

Firmware

Restart

Reset

Users

admin Log out

Restart

Reset

Roles

Logs

Backup/Restore

Reset

Network

Licence Manager

Minimize

Versions

USB

Reset the unit to factory defaults and then powercycle

Restart will cause unit to powercycle 1

2

No. Item Notes

1 Restart This restarts the controller and is the same as powercycling the unit. 

2 Reset This does a Factory reset of the controller. All settings, including Ethernet configuration
and passwords, are reset to their defaults.

DANGER!

Controller must not be in operation

The controller must not be in operation or controlling any equipment when you Restart or Factory reset the
controller.

Make the controller safe for commissioning to avoid equipment damage, personal injury, or unexpected critical
system operations.

NOTICE

A factory reset deletes all controller information

You cannot recover any controller information after a factory reset. All settings, including Ethernet configuration
and passwords, are reset to their defaults.

Make sure that you want to do a factory reset. Create a full controller backup, and store it safely on your
computer. Make sure that you have the information that you will need after the factory reset. This should include
the default passwords, along with the new user and password configuration, and the Ethernet communication
settings.
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More information
See the PICUS manual for how to create backups from your controller.

More information
See Factory reset for the location of the Factory reset button.

5.4.4 Network communication

5.4.4.1 Network settings

You can configure the communication settings for both Ethernet and VLAN configuration.

iE 250 2.0.8.0 MP

NetworkHome

Firmware

Port settings

VLAN settings

Users

admin Log out

Apply Write

Roles

Logs

Backup/Restore

Reset

Network

Licence Manager

Minimize

Versions

USB

State

Description

Auto discover

Autodiscover connected unit type

Port 0

Port 1

Port 2

Port 3

5

1 2 3 4

1

No. Item Notes

1 Network Network settings page. 

2 Port # Configuration for each port. 

3 State Log in / Log out.

Logged in user is shown.

4 Description Description for the port configuration. 

5 Apply / Write Apply the changes immediately.

Write the changes to the controller.
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5.4.4.2 Ethernet ports

You can configure how the Ethernet ports are allowed to operate.

This is for ring topology networks and uses the Media Redundancy Protocol (MRP). The network master is connected to
both ends of the network, forming a loop. This configuration allows the master to send and receive data from both
directions, which is essential for detecting and compensating for a cable break.

With Auto discover selected, the devices connected in the loop are automatically discovered. It is not possible to connect
multiple rings together.

DEIF recommends that you do not use Port 0 (Eth 0) for Auto discover. This is because Auto discover is for ring protocols.

Network > Port settings > Port # *

Parameter Range Notes

State • Auto discover
• Bridge
• Standalone
• Off

Auto discover
• This is for ring topology networks and uses the Media

Redundancy Protocol (MRP).
• The network master is connected to both ends of the network,

forming a loop. This configuration allows the master to send and
receive data from both directions, which is essential for detecting
and compensating for a cable break.

• Automatically detects and uses the network settings. Ideal for
environments where devices need to be quickly and easily
connected without manual configuration.

Bridge
• Connects two network segments, allowing them to function as a

single network. Useful for extending networks or connecting
different network types.

• The Ethernet port is associated to one or more VLAN IDs
depending on the VLAN port mode. Access mode uses a specific
VLAN ID. Trunk mode uses one or more VLAN IDs.

Standalone
• Operates independently with its own network settings. Suitable

for isolated networks or when specific configurations are needed
for a particular device.

Off
• No Ethernet traffic is allowed to or from the port. The port is not

active. This can be useful for Cybersecurity purposes to prevent
unnecessary Ethernet ports being used.

Description - A descriptive name for the Ethernet port. 

NOTE * # is 0 to 3.
NOTE * # is 0 to 4.

5.4.4.3 VLAN configuration

Virtual Local Area Networks (VLANs) allow you to segment a physical network into multiple logical networks. This helps
improve network management, security, and performance.
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Use VLANs to manage the Ethernet traffic routing through the controller's switch. You can configure which VLAN used for
on each Ethernet port.

For Ethernet ports that are configured as Bridge, you configure the VLAN port mode. This can be Access or Trunk.

Access
• Use Access for end devices, like a PC or HMI device. These are typically devices that do not need to be aware of VLAN

configurations.
• The VLAN configured then allows traffic for that specific VLAN only.
• Example: If an Ethernet port is configured as Access mode for VLAN 10, any device connected to that port will be part of

VLAN 10.

Trunk
• Use Trunk for inter-switch links or connections to routers and servers that need to handle multiple VLANs. A trunk port

can carry traffic for multiple VLANs simultaneously. It tags frames with VLAN identifiers to distinguish between different
VLANs.

• Configure which VLANs are used on the Ethernet port.
• Example: A trunk port might carry traffic for VLANs 10, 20, and 30, tagging each frame with the appropriate VLAN ID.

5.4.4.4 Default VLANs

The controller is supplied with three default VLANs preconfigured:
• VLAN for default service communication with unknown devices.
• VLAN for display and remote management communication.
• VLAN for sub-ring process communication.

You can edit the preconfigured VLANs and additionally add more VLANs as needed.

Setting Notes

ID 1 

Description VLAN for default service communication with unknown devices. 

Interface vlan1 

Unit type Unknown unit. 

mDNS Enabled. 

IPv6 Controller IPv6 address and mask. 

IPv4 DHCP enabled.
Controller IPv4 address and mask.

Setting Notes

ID 2 

Description VLAN for display and remote management communication. 

Interface vlan2 

Unit type Display unit. 

mDNS Not enabled. 

IPv6 Controller IPv6 address and mask. 

IPv4 DHCP not enabled.
Controller IPv4 address, mask, gateway, DNS settings.
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Setting Notes

ID 3 

Description VLAN for sub-ring process communication. 

Interface vlan3 

Unit type Base unit. 

mDNS Not enabled. 

IPv6 Controller IPv6 address and mask. 

IPv4 DHCP not enabled.
Controller IPv4 address, mask, gateway, DNS settings.

5.4.5 USB communication

5.4.5.1 Allow or restrict USB access

You can allow or restrict access to the USB port on the controller (where fitted). This can prevent unwanted or unauthorised
direct access to the controller using the USB port.

USB
Setting

Enabled The USB port can communicate and transfer data with any USB peripheral that is connected.  

Not enabled
• The USB port can not communicate or transfer any data with any USB peripheral that is connected.
• Any devices already connected will no longer be allowed to access the USB port.

How to enable or not enable the USB port
1. Launch your browser and enter your controller's address.
2. Open the USB section and toggle the USB setting.
3. The USB setting is immediately applied to the controller.

NOTICE

iE 7 display uses USB port

The iE 7 display uses both the USB and DisplayPort for communication with the base mounted controller. If the
USB port is not enabled, the display cannot send control signals to the controller.
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5.4.6 Versions

The versions page can be useful if you need to contact DEIF support for assistance.

iE 250 2.0.8.1 MP

VersionsHome

Firmware

iE 250 Marine Power Management 2.0.8.1-MP (rev. cde4e1f62)DG 17
Users

admin Log out

Roles

Logs

Backup/Restore

Reset

Network

Licence Manager

Minimize

Versions

USB

REST 1.0.5.0
BSP - Operating system 5.0.3.4 (rev. ge4d25ce)
iE 250 - MIO2.1 - Software 1.0.0.2 (rev. g2edad12)
iE 250 - MIO2.1 - Hardware NA
iE 250 - MIO2.1 - Interface NA (rev. 1.0.0.0)
iE 250 - Controller - Software 2.0.8.1-MP
iE 250 - Controller - Hardware NA
iE 250 - Controller - Interface NA
Engine Control Unit - Caterpillar generic - Software NA
Engine Control Unit - Caterpillar generic - Hardware NA
Engine Control Unit - Caterpillar generic - Interface NA
DEIF DVC 550 - DEIF DVC 550 - Software NA
DEIF DVC 550 - DEIF DVC 550 - Hardware NA
DEIF DVC 550 - DEIF DVC 550 - Interface NA
CODESYS - CODESYS-add-on 0.0.0.0-Unknown (rev. 0)
CODESYS - CODESYS-runtime environment V3.5.20.40
Engine Communication - Database 1.0.3.0
Engine Communication - Protocol 1.0.4.0

2

1

No. Item Notes

1 Version information  Shows the version information. 

2  More options Include or exclude extra information:
• Revisions
• Modules
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6. Cybersecurity

6.1 About Cybersecurity

While DEIF has taken great attention to data security and has designed the product to be a secure product, we recommend
adopting Information Technology (IT) and Operational Technology (OT) security best practices when connecting the
controller to a network.

To minimise the risk of data security breaches we recommend:
• Only connect to trusted networks and avoid public networks and the Internet.
• Use additional security layers like a VPN for remote access.
• Restrict access to authorised persons.

Admin password
To ensure security, change the administrator (User: admin) password the first time that you log in to the controller.

6.2 Permissions

6.2.1 About permissions

The controllers' configuration and functionality is protected with permission access. Only users with the correct permission
may access, configure, or update the configuration or controller settings.

Permission structure
The permissions consist of Roles and Users in each controller configuration. These are stored locally on each controller, or
can be written to all connected and logged in controllers.

Each user is a member of a role. The role gives the user permissions to associated features or functions of the controller.
You can also remove access from a user as required.

Permissions access enables you to easily control which user can access which function. This provides a layer of control for
the operation of the controller.

NOTICE

Permissions access

You can only access the user permissions option if you are a member of a role that has access to that function.

6.2.2 Role settings

Role settings include both Role information and Role permissions.

Role information
The Role information contains the name and automatically recorded changelog.

Setting Type Format Notes

Name Manual Text The Role name. 

Created Automatic Date Date the role was created. 

Changed Automatic Date Date the role was changed. 

Editor Automatic Text The user who created or changed the role. 
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Role permissions
The Role permissions allow or remove access to features in the software.

Parent permissions are required for any child permissions. For example, to allow access to the feature Emulation (a child),
the role must also have access to Application (the Parent). If you remove a parent permission, all child permissions are
automatically removed.

Some features can be configured for Read and/or Write access. With Read only access the user cannot write or update any
information. Read access is mandatory if you allow Write access.

Feature permissions

Live Data Live Data 

Application 
Plant configuration
Emulation
Supervision

Alarms 

Alarms
Alarm acknowledge
Alarm reset latch
Alarm out of service
Alarm shelve

Log 
Event log
Engine interface J1939 DM2
Engine interface J1939 DM2 clear

I/O status I/O status 

Tools 

Print setup
Backup restore
Backup
Restore
Restore configuration
Trending
Regulator status
Alarm test
Firmware
User management
Role management

Configure 

Date and time
Communication
Input/output configuration
Parameters
Counters
CustomLogic
Modbus
Fieldbus configuration
Fieldbus supervision
Dashboard configuration
Header configuration

Not assigned a category 
Feature toggle
Notification configuration
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6.2.3 User settings

Setting Type Notes

User name Required Minimum 2 characters. 

Organisation Optional  

Roles Required Selectable from list.  

Mobile number Optional  

Direct number Optional   

Email (primary) Optional  

Email (secondary) Optional  

Password Required Minimum 8 characters. 

6.2.4 Default user

The default administration user is admin. Only admin can access WebConfig.

User Password Role

admin admin Admin 

NOTICE

Secure your system

Ensure that all default passwords are changed to reduce the security risk to your system. Additionally, it is
recommended to adjust or edit the role and user permissions according to your own operational needs.

NOTICE

Lost passwords

Lost passwords cannot be recovered. If you have lost your password you can not configure your controller or
system.

If you have lost your password, then you must use the Factory reset and reconfigure your controller.

6.3 Network communication

6.3.1 Network configuration

The default is to use DHCP to obtain the IP address, subnet, netmask and DNS servers. If you use a manually configured
(static) IP, be careful to make sure that the selected values match the network to which the controller is connected.

Inbound port 443 is opened to allow communication with PICUS.

Inbound port 502 is opened to allow Modbus TCP communication.

Inbound port 80 is opened and re-directed to port 443.

In addition, the controller may use the following ports for application and PLC communication: 123, 5353, 11740, 1217, 12345,
4321, 12346, 12350, 12351, 503, 1740, 1741, 1742, 1743, 4840, 8000, 8443.
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6.3.2 Untrusted networks

Connections to untrusted networks may require additional equipment and/or security counter-measures that are not
included in the product.

6.4 CODESYS

If you have a CODESYS license you must connect to the controller and log in using the CODESYS IDE. You can then create a
user account and set the password.

6.5 Activity logs

6.5.1 About activity logs

Each controller records activity of both the system and operational events.

These are recorded in logs:
• Event log
• Live system log

6.5.2 Event log

This can be accessed with PICUS or the display.

All activities that require a user login are logged with the username. The user can also use the controller for some actions
without logging in (for example, selecting breaker open). These actions are logged without a username.

The controller stores a maximum of 2000 event log entries. When the log is full, the controller discards the excess log
entries using first in, first out.

If an ECU has been configured, you can also switch to see the DM2 logs.

More information
See the PICUS manual or Operator's manual for how to view the Event log.

6.5.3 System log

This can only be accessed with WebConfig and the admin user.

The Live system log records all different system-related events that occur. These logs can be useful for cybersecurity
control, troubleshooting issues, and also for product support.

These logs include:
• System events and journal.
• Connected session access with WebConfig.
• CODESYS related information.

Download logs
You can select and download the system logs directly from the controller as text files.
1. Select Download from Logs.
2. Select the Duration (period) you want to download.

• This can be Latest, Day, Week, or All.
3. Select the Type of log to download.

• This can be SYSLOG or RLOG.
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4. Select Download to create a ZIP archive with the log files included.
5. Locate your browser's download location to access the ZIP archive.

SYSLOG
The system log (SYSLOG) archive includes:
• Authentication journal.

◦ Connected sessions with WebConfig.
• Reliability log.

◦ Operational values and performance information.
• System journal.

◦ System operations.
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